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1 Introduction
The ControlCenter is the typical user’s day-to-day interface with the system.

Figure 1   - ControlCenter

The ControlCenter gives users a highly customizable platform for viewing live and recorded
video. Features include:

· Flexible and configurable viewing of content on single or multiple monitors, with user-
selected viewing patterns

· Full control of content playback with versatile timeline controls
· Powerful query capability to assist in locating specific content or identifying recordings

associated with motion events
· Thumbnail Search capability, allowing users to scan multiple thumbnail images covering a

chosen time-span 
· Monitoring and management of alarms
· User access rights and privileges set by system administrator allow different users to be

set up to handle specific ranges of tasks
· Preparation of material to be exported for viewing and/or analysis on external systems 

1.1 Best Practices using the Control Center
In order for ControlCenter to run optimally, you need to make sure that the computer
running it is correctly set up. 

You should check the following:

· For each monitor connected to the computer, screen resolution should be set as high as
possible

· Depending on the graphics card you are using, you may need to set hardware
acceleration ON (for some display adapters this is done automatically)

· Your Windows display setting should be set to ‘Smaller – 100% (default)’

· Your Screen Saver option should be set to (None)
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· Your Power Saving options should be set OFF

· In Windows 7, the screen should be set to a Basic mode - Aero modes should not be
used

· In Windows 8, the system should be set to ‘Adjust for best performance’ (Control
Panel/System/Advanced System Settings)

Note: These settings vary depending on the operating system and version you are
using. 

1.2 About this Guide
Welcome to the United VMS 8.0 Latitude, Horizon, Meridian Control Center User Guide.

Note: Changes to this file were last introduced after Application Build No: 5000

This Guide is written for the users of the ControlCenter who are responsible for monitoring
live and recorded video and handling alarms.

A separate publication, AdminCenter User Guide, covers the setup and operation of the
overall System.

Summary of latest changes:

Change Date
Changed

Summary Links

Index May 2017 Index expanded

Dual-Sensor
cameras, Picture-
in-Picture display

Nov 2016 Control Center supports display of Dual-
sensor cameras

Dual-Sensor
Cameras in
Navigation Pane

Dual Sensor
Cameras -
Picture-in-
Picture view

About this Guide May 2016 This new topic was introduced so that users
could see the file status and have a
summary of relevant recent changes.

(This topic)

MP4 May 2016 The option of exporting in .MP4 format was
introduced.

Exporting

FLIR Branding March 2016The United VMS 7.0 suite was re-branded.

Please note: This is not a formal Change Register - the list is included so that users can quickly
access Topics that contain new or changed information.

File information:

Source file: O:\_Project\8.0\PROD_CC_DOC\
ControlCenter_User_Guide.pdf 

Date
complied:

Wednesday, May 17, 2017
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1.3 More Information – Help System

Accessing the Help file
Click Help in the Main Menu bar, and then select Help. 

Alternatively, each pane provides a context-

sensitive Help icon , which takes you directly to
the section of the Help system that deals with that
specific part of the display. 

Once the Help window is open, you can open the full Table of Contents by right-clicking on
Contents and selecting Open all.  

Figure  2 - Accessing Online Help

A Search tab allows you to find keywords within the Help system. 

You may also use the Favorites tab to select topics and put them in a custom list for easy
access.
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2 Control Center Workspace
The main screen of the ControlCenter is the user’s window into the monitoring application. 

Figure  3  - ControlCenter - Main Screen

The workspace is organized into ‘panes’ - where the different parts of the system are
shown.

Explorer Area

Viewing Pane
(Contains the Viewing Tiles 

arranged according to the current Layout)

    

Navigation Pane
    Navigation Tree 

(in Latitude systems)
Case Builder Navigation Tree

Query/PTZ Pane

     PTZ

     Query

     Motion Query

     Case Builder Query   

Workspace Pane
Query Results / File Playback / Timeline

Alarms Pane / Export Status / Events Pane
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Figure  4  - ControlCenter - Workspace Panes

· The Explorer Area normally has two sections:

o The Navigation Pane lists cameras and other entities that make up the system, and
lets you choose what to show in a tile of the viewing pane. 

o The Query/PTZ Pane allows you to operate Pan Tilt Zoom cameras, 
-or- 
one of the Query Tabs. 
The Query or Motion Query Tabs allow searching for clips that have been recorded.
The system lists the results of a query in Query Results Tab in the Workspace Pane.
You can then click a query result and drag it to a Viewing Tile to view the recorded
clip.  

· The Viewing Pane has many options for the user. You can choose the number and
arrangement of tiles from the Tile Layouts list on the right of the screen. Each tile can be
used to display live and/or recorded video, site maps, stored operating procedures, and
other information. Predefined Viewing Layouts can also be used to allow you to store
your own favorite layouts to be recalled when required.

· The Workspace Pane which, when opened, can show one of the following Tabs:

o Query Results Tab shows details of all information retrieved as the results of a Query.

o Case Builder Query Tab (when connected to a Latitude system).

o File Playback Tab allows the user to play clips that were exported in the Flir .dvt
format. It also allows synchronized playback of multiple files. 

o Events Tab lists Events that have occurred during the current login session. 

o Alarms Tab lists currently active alarms and alarms that have occurred during this login
session. It also allows the user to handle them (that is, to trigger, accept, snooze or
close, etc.)

o Timeline Tab allows you to browse through details in a recorded clip

o Export Status Tab displays the status, location, time and progress of ongoing and
completed exports.
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2.1 Pane Tabs
Panes are used to display different types of information.  The user can switch between the
different views without losing the information in each. This is done by clicking on the Tab
buttons of the pane.
Each Pane has a set of Pane Tabs which allow the user to choose what to display in that
pane.

Figure 5 - Pane Tabs

Navigation Pane Tabs

Tabs: Navigation Tree

Viewing/Layout Tabs 
(Above the Viewing Pane)

Tabs are shown for all Layouts that are in use.

PTZ/Query Pane Tabs

Tabs:  Motion Query, Query and
PTZ Control

Workspace Pane Tabs

Tabs: Query Results, File Playback, Timeline,
Alarms, Export Status and Events

Note: When connecting to a Latitude System, the Case Builder and Case Builder
Query Tabs are shown in the Navigation Pane and Query Panes, respectively.
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2.1.1 Main Menu Bar

A menu bar allows the user to make simple setup changes to the ControlCenter. 

There are 4 entries in the Main Menu Bar: 

· File Menu

· View Menu 

· Tools Menu

· Help Menu

Figure  6 - Main Menu Bar

File Menu

The File Menu allows you to:

· log on and off

· connect to or disconnect from additional
systems 

· change user password

· open files that have been stored outside the
system

View Menu

The View Menu lets you 

· open default layouts

· set what content windows are enabled

· define what the system should show when you
request a full-screen view.

Tools Menu

The Tools Menu opens an Options tree. The
default settings  suit most users, but you may use
the wide range of customization options as shown
in the Tools Options Menu section.

Help Menu

The Help Menu allows you to open the full Help
System to check for system updates, and to open
an ‘About’ panel that displays the ControlCenter
Version information.
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2.2 Enabling/Hiding Tabs
You can control which Tabs are available in your ControlCenter – In the Main Menu Bar,
click View/Contents. A drop-down list of available tabs is shown, and by clicking on any
option, you can set it to be hidden or visible.

You can deselect tabs either by un-
checking them in this drop-down, or

by clicking on the minimize icon 
while they are open. 

Caution:  If Tabs are unchecked
in the View/Content menu, they are not
shown on their respective panes. 
To access them again, you must go
back to the Main Menu bar, re-select
them by clicking on View/Content to
reopen the drop-down, and click the
ones you want to use. 

Figure 7 - Selecting/Deselecting Tabs to be available

2.3 Toolbars
Each pane has its own Toolbar – allowing the user to carry out functions directly related to
the contents of that pane. The functions of each Toolbar are discussed in the detailed
description of the corresponding section.

Navigation Pane Toolbar

Buttons: Refresh, Filter, Site Filter, Delete (future use)

Viewing Pane Toolbar

Buttons: Full screen, Layout Tour, Add Layout, Save, Clear, Volume controls
              System Details

Workspace Toolbars

Events Pane Toolbar:

Buttons: Clear, Edit, Group, Filter

Query Results and Motion Query Results Toolbar:

Buttons: Clear, Export, Lock, Edit, Group
Note: When connected to a Latitude System, the Add to Case button is shown.
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Alarms Pane Toolbar

Buttons: Accept alarm, Forward, Snooze, Show procedure, Clear alarm,
Trigger an alarm, Filter

2.4 Transparent Sidebar
You’ll see a faint outline of an arrow on the left of the screen – clicking on this gives you
access to the Sidebar, which provides different modes of operation that you can use,
depending on what functions you need to concentrate on. 

· To access the sidebar, hover over the left border of your workspace until the faint outline
changes to a fully colored arrow, and then click the arrow to expand the sidebar.

· To collapse the sidebar, click the arrow on the sidebar.

Sidebar hidden Sidebar opened

Figure 8 - Using the Sidebar

You can switch the layout of the ControlCenter screen to suit a particular task with a single
click.  The Sidebar gives you six modes of operation - Supervisor, Monitor, Forensic,
Case Builder, Access Control, and Favorites.  Each mode gives a predefined
arrangement of the screen in which to best perform the task it is named after.  Favorites
mode allows you to save your own screen arrangement for reuse in the future.

Mode Function Panes
Supervisor Overview of the security

environment
Navigation, Query, Alarms, Viewing

Monitor Live video and audio monitoringNavigation, PTZ, Alarms, Viewing

Forensic Search and review recorded
information

Query, Query Results, Viewing

CaseBuilder Collect & review recorded data
as ‘cases’

CBNavigation, CBQuery, Alarms, Viewing

Access Control Unified video and access
control system

Navigation, Query, Combined Alarms &
Events, Viewing

Favorites Allows you to save a
ControlCenter layout 

Custom

Table 1 - Sidebar Modes
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3 Workspace Pane
The Workspace Pane is used to display various informative tabs. 

The following Panes are displayed by clicking on the corresponding icon in the Workspace
Toolbar:

Icon Pane

Query Results

File Playback Pane
Timeline Pane

Alarm Pane
Export Status Pane

Events Pane

3.1 Explorer Area
Navigation Pane

How to search the Navigation Tree

Searching using the Search Box

Using the Navigation Tree Filter

Using the Highlight button in the Navigation Tree

Navigation Tree Context Menus

Query Pane

Making a Query

Type of Search

Entities to include in Search

Summary of Query Pane elements

Advanced parameters

Query Tab Toolbar

PTZ Control Pane

Digital PTZ

Using Presets in Scene Tracker Mode (only when connected to Latitude systems)

Motion Query Pane

Setting up a Motion Query – Common parameters

‘Motion Indication’ Query

‘Smart Search’ Motion Query

‘Motion Bookmark’ Query

Workspace Pane

Query Results Pane

‘Clip’ Query Results

‘Bookmark’ Query Results

‘Incident’ Query Results  (only when connected to Latitude System)

‘Alarm’ Query Results

'Motion Query' Results 

File Playback Pane
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File Playback Tab Toolbar

Timeline Pane

Alarm Pane

Alarms Tab Toolbar

Alarm priority and color coding

Export Status Pane

Export Status Tab Toolbar

Events Pane

Events Tab Toolbar

3.1.1 Navigation Pane

The Navigation Pane is a tree showing all the logical entities (sites, cameras, tile layouts
etc.) which the user is authorized to view. 

Figure 9 - ControlCenter Navigation Tree - Main features

A full list of all the entities that can be shown in the Navigation tree, and all the additional
symbols that indicate their status is given in the section Table of Navigation Tree Icons

Note: Some Entities are only supported on Latitude systems (Examples: Enterprise
symbols, Microphones, Scene Tracker scenes)

Navigation Tree Entries
The Navigation Tree contains all Sites (these can be expanded to show all logical entities
within each Site) and all entities not allocated to specific Sites. 

Clicking the Site Filter icon  opens the Site Filter, which  allows all or only some of the
Sites to be shown.
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Note: Sites and Entities displayed can be limited by the Access Rights associated
with specific Users or groups of users as set up by the System Administrator.

The following display modes show information about the entities in the Navigation Tree:

o Bold entries refer to camera entities which are currently displayed in viewing tiles.

o Green entries refer to Analytics-capable cameras that are currently Armed.

o Red entries refer to Analytics-capable cameras that are currently Disarmed

Dual-Sensor Cameras in the Navigation Pane
Dual-Sensor cameras that are integrated into the system (such as the FLIR PT-Series) are
shown as two entries in the Navigation Pane

When one of the pair is selected for a viewing pane, then that camera is shown as the 
primary display in the Viewing Pane, and the other member of the pair is shown in the
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Picture-in-picture pane (i.e. the secondary display). The name of the camera in the
primary pane is shown in bold in the Navigation tree. 

If the user toggles the Picture-in-Picture window in the viewing pane so that the other
member of the pair becomes the primary display, then in the navigation tree, the bold
indication switches to the other member of the pair.

(See Dual Sensor Cameras - Picture-in-Picture view) 

3.1.1.1 How to search the Navigation Tree

There are lots of options for searching the Navigation tree, so even if you have a really big
installation with hundreds of cameras and other entities, or if you are monitoring more than
one system, you can  find any item you are looking for. 

If the search window is not visible in the Navigation Tree, click the Expand/Collapse bar.
This opens the search window.

Figure 10  - Opening the Search Bar

3.1.1.1.1  Searching using the Search Box

You can search for a camera or other entity by name (or a part of the name). When the
search box is empty, you see all the entities in the tree.

The examples below show how, once information is entered in the search box, the tree
shows only those entities that match the search information (with their relevant
‘organization’ entries, such as system, enterprise and/or site). 
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Empty (Show all) ‘cam’ ‘qa’

Figure 11 - Using the Navigation Tree Search Bar

3.1.1.1.2  Using the Navigation Tree Filter

The Filter tool allows you to choose what
types of entities are shown in the
Navigation tree.

Click the Filter icon to open the drop-down
list. 

You can include or exclude any of the types
of entity by checking/un-checking them.
The ‘Select all’ and ‘Select none’ entries
allow you to reset the whole list quickly. 

Note: ‘Organizational’ entries such as
the System/s, Organizations and Sites
are always shown.
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The examples below show how the list of entities in the Navigation tree changes when you
use the Filter.

Show All 
Show None 

Shows only Organization Icons Show Cameras 

Figure 12  - Using the Navigation Tree Filter Tool

3.1.1.1.3  Using the Highlight button in the Navigation Tree

Clicking on the Highlight button  changes the
way that the search box works. Instead of hiding
entries that don’t match, you  see the whole tree,
but with highlights on all the entities that match the
information in the search box.

Clicking on the Highlight button toggles this
capability on and off.

Figure 13 - Navigation Tree Highlight Button
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3.1.1.1.4  Navigation Tree Context Menus

Right-clicking on an item in the Navigation tree
opens a Context menu, giving you access to some
quick actions for that entity.

 

The options in the Context menu vary according to the type of entity.
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Analytics-Related Context Menu Entries
Context Menu Item Comments

Batch
Arm/Disarm

(Shown in the Context Menu when the System is selected in the
Navigation Tree)

Opens the Batch Arm/Disarm dialog box, listing all Analytics-capable
cameras, and allowing the user to arm or disarm Analytics in one or
more cameras

Arm/Disarm (Shown in the Context Menu when an Analytics-enabled camera is
selected in the Navigation Tree)

Allows the user to arm or disarm Analytics in the selected Analytics-
capable camera 

The Analytics arming status of individual cameras is shown in the 
Navigation tree

Batch Arm/Disarm Dialog
When using ioi Analytic-enabled cameras, the user can open a Batch Arm/Disarm Dialog
box to arm or disarm the Analytics feature in one or more cameras.

Print Snapshot Dialog
If the Print Snapshot option is clicked in a Viewing Tile Context menu, then the Print
Snapshot Dialog box opens, allowing the user to set the required print parameters.
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Note: When printing an image larger than the paper size, the image is scaled down to
fit the page.

3.1.2 Query Pane

The Query Pane provides an easy-to-use interface
for searching the system's video and audio
archives. It supports searching based on date and
time for Clips, Thumbnails, Bookmarks, and
Alarms. 
It is also used to launch Playback.

Access the Query Pane by clicking the Query icon

 in the Explorer Pane. 

You can also open the Query Pane by right-clicking
on a live video tile and selecting Send to Query.

Note: On Latitude Systems, you  may also
search based on Background Export Clips and
Incidents.
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3.1.2.1 Making a Query

The Query pane provides an interface for searching the system's video and audio archives
and displaying the search results in the Query Results pane. It supports search of the
selected unit’s recorded .dvt files using the search parameters of text and time stamp on
either stored clips, bookmarks or alarm information.

Note: On Latitude systems, one may also query on  Background Export Clips and 
Incidents.

3.1.2.1.1  Type of Search

Use the Search for drop-down to select what kind of query is required.

· Clip
Searches video clips recorded by the selected
camera

· Thumbnails
Allows user to select a camera, set a time-frame,
and display a set of thumbnail images covering the
selected time

· Bookmark
Searches the bookmarks attached to the
recordings 
Note: Video motion bookmarks can only be
accessed via the Motion Query pane.

· Background Export Clip
– see Help File

Note: Only available when connected to a Latitude system
· Incident

Searches incidents for the selected
camera/microphone/s

· Alarm
Searches alarms and clips associated with alarms



20
May 17, 2017

Workspace Pane

United VMS 8.0 Control Center User Guide

3.1.2.1.2  Entities to include in Search

Select the entities to include in the search by
checking their respective tree entries.

You can use the Highlight field  to assist in
choosing the correct entries, and the Text search
field to limit the number of entries that are displayed
in the Navigation tree.

For Thumbnail Search, one camera is selected for a
Query

The items in the Navigation tree change depending on the Search Parameters. 

If you are searching for 
Alarms, then the

Navigation tree lists all
the Alarm Types

If you are searching for 
Bookmarks, then the

Navigation tree lists all
the Cameras
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3.1.2.1.3  Summary of Query Pane elements

Element Description

‘Search for’
Query type drop-down

Select which type of Query you want to do – Clip,
Thumbnail, Bookmark, Incident or Alarm. (See Type of
Search)

Note: The type ‘Background Export Clip’ is an advanced
function. (see the Help File)

Additional Parameters
(‘Advanced’ icon) 

For each type of query, you can click the Advanced icon,
and specify additional selection criteria 
(see Advanced Parameters below)

Filter Box Enter text here to filter the information in the Navigation
Tree.

· If you click the highlight button ON , then all the
entries in the Navigation Tree are shown, with any
entries that match the text you enter highlighted.

· If you click the Highlight button OFF  , then the tree
only shows entries that contain the text you entered.

Navigation Tree Select which entities/scenes are to be searched

Text Search Allows you to further reduce the query, by only including
entities that have this text string in their names

Time Selection Limit the search to one of the following:

· Last 24 hours

· Last 48 hours

· Past week

· Anytime

· Manual Selection - only those clips that are dated within
these date and time parameters

Reset To reset your query parameters, click the Reset button 

Sync Launches a Synchronized Playback Layout, that
simultaneously plays the cameras/microphones that were
specified in the Synchronized Search
See Synchronizing multiple sources (Synchronized
playback)

Go Start a Regular search. Lists all matching results in the
Query Results pane. 

Remember: You can edit the Search and add/remove items from the search list. If

you want to start a new search, use the Reset button   to clear the list.
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3.1.2.1.4  Advanced parameters

Depending on type of Search, you can specify additional parameters by clicking on the 

Advanced parameters icon 

Clip - which user/s
initiated the clip,
what triggered the
clip, etc.

Thumbnail - should
the search include
clips recorded on
Redundant
Archivers?

Bookmark/Incident
- which user/s
initiated the
bookmark/incident

Alarm - which
user/s initiated the
alarm, Text in the
Alarm description,
Alarm priority

3.1.3 PTZ Control Pane

PTZ stands for Pan, Tilt, and Zoom and traditionally indicates a camera that has
motorized capabilities to tilt up and down, rotate to pan left and right and a motorized lens
magnification for zooming in and out on the scene. 

With modern cameras, these PTZ capabilities are extended with digital panning, tilting and
zooming.

Some cameras offer exclusively digital pan, tilt, and zoom. 

Additionally, the layout tiles provide additional magnification and movement around the
magnified tile image but this is not done via the PTZ control panel.

The PTZ control panel is displayed on the left side of the ControlCenter by selecting the

PTZ icon  in the Explorer pane. 
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The Preset area of the PTZ Control Panel allows the following functions:

· PTZ control: When a PTZ camera type is selected, the camera can be controlled
directly

· Preselect Selection: Clicking on a Preselect button moves the camera to show the
preset view associated with that button.

· Preselect Settings: This area allows each preselect to be named (Edit), and stored
(Set). The camera's pan, tilt, and zoom settings are stored. One preset may be defined
for each numbered load button.

· Aux Mode: When an auxiliary, PT  or PTZ auxiliary device is selected, much like
standard PTZ presets, the aux mode allows preset of a pan tilt and zoom stored to
memory. It is for devices that work on the same principals as a PTZ camera (e.g. a PT
motor or servo). 
This allows one preset defined for each numbered load button.



24
May 17, 2017

Workspace Pane

United VMS 8.0 Control Center User Guide

 

To move the camera: Use the directional buttons.

To zoom in and out: Click the  and  buttons, respectively.

To move the camera to its home position: Click the  button.

To flip the camera: Click the  button.

To lock the camera: Click the  button.

To move the camera to a Preset: Click the button labeled with the preset number.

To adjust the Iris, Speed and Focus settings: Use their respective + and - buttons.

3.1.3.1 Digital PTZ

There are two methods available to use the Digital Zoom capability:

· Digital PTZ using Draw-to-zoom

· Digital PTZ using the mouse

While Digital Zoom is in use, a Digital Zoom Indication is shown. 

Digital zoom is canceled using the Viewing Tile context menu (Right-click in the Viewing
Tile and select Reset Digital Zoom). 

3.1.3.2 Using Presets in Scene Tracker Mode

Note: Only available when connected to a Latitude system

When a defined Scene Tracker view is selected, it works like a digital version of a PTZ
preset that remembers the view that was loaded when the preset was defined. Allows one
preset to be defined for each numbered load button. 

3.1.4 Motion Query Pane

The Motion Query Pane allows you to search for clips that have specific motion
characteristics. In addition to date and time criteria, Motion Queries can be done in three
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different ways - Motion Indication, Smart Search, and Motion Bookmark. In the Motion
Query pane, you can choose one of the three search types. Choosing which one to use,
and setting the parameters for the different types of search, are covered below.

Access the Motion Query Pane by clicking the Motion Query icon  in the Explorer
Toolbar.

Motion Indication Search Smart Search  Motion Bookmark Search

Figure 14 – 3 types of Motion Query

3.1.4.1 Setting up a Motion Query – Common parameters

Element Description

Query type drop-
down

Select which type of Query you want to do – Motion Indication,
Smart Search, and Motion Bookmark. (See descriptions below)

Select Scenes Select a camera -> smart-search users can select only a single
camera at a time

Time selection Limit the search to one of the following:
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Element Description

· Last 24 hours

· Last 48 hours

· Past week

· Anytime

· Manual Selection - only those clips that are dated within these
date and time parameters

Motion Search
parameters

See descriptions below

Reset
To reset your query parameters, click the Reset button 

Search redundant
archivers

Check this box if you want the search to include material stored
on Redundant Archiver/s
Note: Only available when connected to a Latitude system

Go Start a search. This lists all matching results in the Query
Results pane. 

3.1.4.1.1  ‘Motion Indication’ Query

A Motion Indication Query uses information provided about the whole camera’s field of
view. You set a percentage of movement in the clip to be used as a threshold. The system
returns instances with matching or higher values. 
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3.1.4.1.2  ‘Smart Search’ Motion Query

Smart Search searches for motion in a
specific ‘area of interest’ and three detection
parameters that you define.

Element Description

Drawing
Tools

Use these buttons to draw the
area which is to be examined

Use the left mouse button to
‘Hold and draw’ a rectangle

Select the whole picture field

Clear individual blocks

Draw individual blocks

Clear the whole picture field

Threshold Set what proportion of the
selected Macro block must
change in order to be
considered a ‘movement’ 

Consecutiv
e frame hit

Specify how many consecutive
frames must be over the
above threshold, for
movement to be registered.

Accurate/F
ast

Set how precise the sampling
is to be – ‘Accurate’ makes the
search take longer, while
‘Fast’ gives results more
quickly, but with less precision

You can only select one camera for each Smart Search motion query. Once you select a
camera, the Preview button is enabled. Click the Preview button, and use the Drawing
buttons to set up the area to be examined (the ‘Macro Block’ – marked with green
squares). 

Set the Threshold and Consecutive frame hit parameters, and the Accurate/Fast slider.  

Once you have set up the parameters, click Go to start the search.
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3.1.4.1.3  ‘Motion Bookmark’ Query

Motion bookmarks are system-generated bookmarks that are created if the camera is set
up for creating  bookmarks upon 'motion on'. 

Note: In Latitude systems, these settings may be set up in the AdminCenter.

The text search limits the search to bookmarks which contain the text string entered in the
text box.

3.2 Query Results Pane
The Query Results window depends on the type of Query you used. 

Clip Query Results

Bookmark Query Results

Incident Query Results 
Note: Only available when connected to a Latitude system
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Motion Query Results
The output results of a Motion Query are displayed in Query Results pane. Each line in the
results table represents a clip in which motion was detected. A clip can be launched into a
Viewing tile, and information about the clip is shown in the Timeline. The clip’s track in the
Timeline includes times where the motion detection was measured and found (red areas),
as analyzed by the system over various time criteria.  

3.2.1 Query Tab Toolbar

The Query Tab Toolbar gives the following capabilities.

Icon Description

Clear the selected results 

Export the selected Clip/s 

Lock/unlock the selected Clip/s - Clips are protected and are not overwritten when system overwrites oldest recorded clips

Validate the stored clip to confirm that it has not been edited

Can be used to edit Bookmark Description

Click to arrange the Clips – Un-grouped/By Scene/By Incident

Add selected Clips/Alarms to the open case in the CaseBuilder Navigation Tree. 
(See Case Builder)

Table  - Query Tab Toolbar

Note: Only available when connected to a Latitude system
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3.3 Thumbnail Search Results Pane
When a Thumbnail Query is executed, the Viewing Pane shows a set of Thumbnails and a
Playback Pane.

3.4 File Playback Pane
The File Playback pane is plays clips exported in .dvt and/or .avi format. 
In the File Playback pane, you can also validate the authenticity of .dvt format clips, and
indicate whether or not a clip has been tampered with.
You can select individual clips or the content of whole folders to be added to the File
Playback pane.
Once a clip has been added to the File Playback pane, it can appears in the Viewing Pane. 

In addition, it is possible to play clips synchronously - multiple media clips from different
sources can be synchronized and played simultaneously.  For more information, see the
Help file.
Once a clip starts playing, the Timeline pane is displayed.

File Playback Pane Toolbar

The File Playback Tab Toolbar gives the following capabilities.

Icon Description

Opens a dialog box where you can select clips to be added to list in the
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Icon Description

Playback Tab

Select folders to be added to list in the Playback Tab

Remove selected entries from the Playback list

Runs a validation using the proprietary .dvt digital signature to determine if
the clips loaded and selected in the File Playback have been altered or
damaged.

Toggle the File Playback list to display either grouped by scene (camera)
or list individual clips un-grouped.

Select or Clear the check boxes for all the scenes and clips in the list.

Plays the selected clip or clips in one or more tiles.

Figure 15 – File Playback Tab - Dialog window
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3.5 Alarm Pane
The Alarm Pane is used both to trigger alarms and to handle them. It consists of two
parts: a toolbar with number of buttons at the top of the pane, and a table that displays
basic information about the alarms the user has received during the login session.

Alarm Query Results

Alarms Tab Toolbar

The Alarms Tab Toolbar gives the following capabilities.

Icon Description

Accept/Unaccept the selected alarm (Toggle). 

Accept: When one recipient accepts an alarm it is locked for use by any
other recipients. It is possible to unaccept an alarm after it has been
accepted to release it to other users.

Unaccept: When a user accepted and alarm and wants to reverse the
acceptance and allow others to accept and clear the alarm

Snooze the selected alarm (the snooze duration can be specified by going
to Options in the Tools menu. The default value is 60 seconds).

Forward the alarm to another user.

Clear an alarm or alarm related action from the table. Once an alarm is
Cleared, it is removed from the list.

Show Procedure: Displays the procedure associated with this display.
Procedure is displayed in a tile that is Armed for alternative content.
(Only enabled if there is an associated procedure

Manually trigger an alarm

Filter the alarm information shown in the pane based on alarm state in the
list below:

(One or more categories may be checked)

Alarm Priority and Color Coding
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When alarms are defined in the AdminCenter, they are assigned priorities (1=high –
100=low).
Note: Only available when connected to a Latitude system

The system has the option of displaying alarms with color coding. This is enabled by
checking Enable color coding in alarms management in the System/General screen,
Alarms panel.  If this option is enabled, then Alarms listed in the Alarm Tab appear in
colors corresponding to their priority level. 

Figure 16- Alarm Color coding

3.6 Export Status Pane
The Export status tab shows a progress bar. 

Export Status Tab Toolbar

The Export Status Tab Toolbar has two icons.

Icon Description

Clear Finished / Clear All

Stop Selected / Stop All
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4 Viewing Pane and Viewing Tiles
The Viewing Pane can be displayed as a single tile, but is usually divided into a number of
Viewing Tiles, depending on how you want to organize the screen. 

In this section, we’ll discuss all the elements that you can see in each viewing tile, and the
overall structure of the Viewing Pane. 

4.1 Events Pane
The Events Pane lists events that have occurred since the current user logged on to the
system. Only events of the types to which the user is subscribed are displayed.

Events Tab Toolbar

The Events Tab Toolbar has 4 icons – Clear, Edit, Group, and Filter.

Icon Description

Single event – Select the event and then Click ‘Clear’.

To clear all, click the drop-down arrow and then click ‘Clear All’

Edit the Description for a Bookmark/Incident event 
(Edit is not enabled for other types of Events) 

Group entries in the Events list by any of the following:

Type, Date, Initiator, Description, Firing Entity

Filter by any of the following (i.e. only entries of the selected types are
shown)
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4.2 Structure of the Viewing Tile
Each Viewing tile contains icons and optional text information to describe its content and
status.

Figure 17  - Viewing Tile - Information about the tile

4.2.1 Tile Toolbar

The tile toolbar buttons change according to the content being displayed in the tile. If the
tile is showing a live picture, you have buttons that allow you to start recording. If it is
showing a Playback, then you have playback controls – RWD, Play, Pause, FFWD, etc. 

The list below shows the controls available, depending on the type of content in the tile.

Live Camera

(Fixed)

Draw-to-Zoom, Start Recording, Instant Replay

Live Camera

(PTZ)

Start Recording, Instant Replay

Live Camera
Linked Mic

Start Recording, Instant Replay, Volume control

Live Camera
Linked Mic 
& URL

Start Recording, Instant Replay, URL link, Volume control

(Clicking the URL link opens the URL in the next available tile)

Playback
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Rewind, Play, Pause, Fast Forward

Alarm

Accept, Snooze, Cancel

Flashing red border indicates that the Alarm is not yet accepted

Alarm

Accept, Snooze, Cancel, Previous Scene, Pause Sequence, 
Next Scene

Sequence

Previous, Pause, Play, Next

Map

Previous, Home, Next

Microphone

Start Rec, Instant Replay, Mute, Volume

See full list of Viewing Tile Toolbar buttons - Viewing Tile Action Buttons

4.2.2 Tiles Status Icon

The icon in the top right corner of each viewing tile shows the type of content being
displayed.

Icon Content Type

Live video – camera is not recording

Live video, and the camera is currently recording

  Playback

Sequence – you see the output of more than one camera, with the view changing at
regular intervals

(shown alongside the tile status icon) – this content is associated with an alarm

4.2.3 Tile Arming Status

Specific tiles can be set up (‘armed’), so that they receive content that is ‘sent’ as a result of
events that occur in the system. Tiles are armed by clicking on the Tile Number. 

Click
number

Color of 
Tile Number Status

Un-clicked
Grey

Unarmed: Indicates that the Tile is not armed and behaves
according to the configured default Layout behavior for
unarmed tiles.

First Armed  for Alternative Content: Content such as Instant
replay may be sent to this tile
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Click
number

Color of 
Tile Number Status

Orange

Second
Red

Armed for Alarms: This tile is available for Cameras that
must be displayed as the result of an Alarm

Third

Grey

Returns to unarmed state

4.2.4 On-Screen Display (OSD)

The On-Screen Display is shows information in the viewing tiles. Options include the name
of the camera or other entity being displayed, its status, video characteristics, and so on.
You can display or remove the various On-Screen Displays, by opening 
Tools/Options/View Settings/OSD and changing the settings there.

Figure  18 - Setting OSD Parameters
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4.2.5 Dual Sensor Cameras - Picture-in-Picture view

Dual Sensor Camera (Dual-Head) Picture-in-Picture Display
When viewing output from a Dual Sensor Thermal/Visible camera that has been integrated
with Latitude, such as  the FLIR PT Series, the viewing tile presents a Picture-in-Picture
view of the Thermal and Visible scenes.

Both cameras appear in the Navigation Pane.

Both Images are shown in the viewing tile. The camera corresponding to the primary
image (full tile) is shown highlighted in the Navigation Tree. 

Visible Image Primary Thermal Image Primary

Dual Sensor Thermal/Visible Camera

Using the Picture-in-Picture display
The user can switch between viewing the Visible or Thermal images as primary by double-
clicking in the viewing tile's Picture-in-Picture window. 

(The corresponding entry in the Navigation tree is automatically adjusted when the user
does this.)
Double-clicking in the main window of the Viewing tile makes the viewing tile full-screen, as
for any other viewing tile.

When the mouse is inside the Picture-in-Picture window, the user has additional controls:

· to minimize the P-i-P window, click the Minimize icon  

· (to re-open the P-i-P window, click on the P-i-P icon  that
appears in the margin when the image has been minimized.)

· to re-size the P-i-P window, drag the Re-size icon 

4.3 Viewing Pane Information
Viewing Pane Toolbar

Tile Context Menu
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Default Layout

Full Screen

4.3.1 Viewing Pane Toolbar

The Viewing Pane Toolbar has a number of Video and Audio Controls and some fields that
show information about this monitor. The buttons of the video and audio controls are active
only for the currently focused tile (outlined in yellow).

Icon Video Controls

The current tile is expanded to fill the Viewing Window (toggle)

Start a Layout Tour (Toggle) - When clicked, the viewing pane cycles
through all defined layouts. The dwell time for the cycle is defined in 
Tools/Options/View Settings/Layout. 
Clicking on the icon a second time stops the Layout Tour.

Add Layout - see How to add or modify a Layout

Saves the current layout – the user can save a layout with the current
cameras and the current settings for arming tiles.

Note: Cannot be used for the default layout.

Removes the content from the currently active tile/s.

Note: When connected to a Latitude system, the toolbar also includes a 'Create
Incident' icon.

Icon Audio Controls

Volume control for current selected Audio tile/s

Mute control for current selected Audio tile/s

‘Solo’ button – mutes all audio from tiles except those currently selected.
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Icon/Detail ControlCenter Details

This section of the toolbar lists the System number, the current monitor, and the scenes in
the various tiles, the number of active alarms, and the workstation's Layout ID and Logical
ID. These are needed when operating a ControlCenter from a CCTV Keyboard. See  
Using Keyboards.

Logical ID

System

The current System number

Monitor ID

Monitor

The logical ID of the current monitor

Tile Shows the Tile Number of the currently active tile

Scene The logical scene number as noted in the Navigation Tree 

Shows number of alarms, for which this user is a recipient, that are
currently open

Input Area When a keyboard is used to enter a parameter (such as entering an entity
number - a camera or a monitor number) this is displayed in this field

Monitor The current Layout ID and Monitor Logical ID

Push bar – allows the pane to be maximized/minimized
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4.3.2 Tile Context Menu

If you right-click in any Viewing Tile or the Navigation tree, a Context Menu opens.

Figure  19 - Context Menus in different Panes

The Context Menu varies depending on the contents of the window from which it was
opened.

Context Menu Item Comments

Batch Arm/Disarm
Only shown when mouse

is on System entity
Opens dialog for Arming or disarming Analytics functionality

Disconnect from
system

Only shown when mouse
is on System entity

Allows user to disconnect in preparation for connecting to another
Latitude system

Show only this tile/ 
Show all tiles

Changes this tile to a single-tile display

Take Snapshot
Saves a snapshot of the video from the selected tile in the default

export folder defined in the Tools menu.

Lock Tile/
Unlock tile

After dragging a content to tile and locking it, user cannot replace
it with any other content until the “lock tile” check is removed
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Context Menu Item Comments

Spot monitor

Clicking on Spot Monitor defines this tile to be the destination for
any video opened by double-clicking on a camera or a map in the

Navigation tree, or a clip in the Query list. 
The Spot Monitor is also used when video from a remote

ControlCenter is to be shown. 
Note: Only one tile can be set as the Spot Monitor at any one

time.

Full Screen/
 Exit Full Screen

Displays this tile in full-screen mode. Revert by right-clicking again
and selecting ‘Exit Full Screen’, or otherwise press ‘Esc’ 

Remove Clears this tile

Clear
ioimage units only 

Clears the alarm triggered by the ioimage camera

Arm/ Disarm
ioimage units only 

Arms/disarms ioi unit.

Save as preset
If the user has used the in-pane controls to change the view in a
viewing tile, the resulting view can be saved as a digital preset 

Go to preset
If digital presets have been saved for the camera being displayed
in this viewing pane, the user can select them by clicking on Go to

preset, and then selecting the required preset number / name.

Send to Query
Sets the selected unit as a filter in the Query pane so that all

recordings from that camera can be selected

Start manual record/ 
Stop manual record

Only in Nav. Tile menu
 Same function as clicking the Record button in a camera tile.

Display
Only in Nav. Tree menu

Displays video from this camera in the next available tile

Instant Replay
Only in Nav. Tree menu 

Starts replay of the recording of this scene, in next available tile
that is armed to show replays. Replay can also be started from the

IR icon in a Live tile.

4.3.3 Default Layout

At the top of the Viewing Pane, the user can open the default pane (this is true for every
ControlCenter monitor). Additional Layouts (Viewing Tabs) may be set up by ControlCenter
users (see How to add or modify a Layout). This allows you to have several different
layouts of the Viewing Pane that you can access quickly, simply by clicking on the Viewing
Tab. 
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Using the Default Layout drop-down of the View Menu, you can check the Default
Layouts entries if want to the system to open with the default layouts.

4.3.4 Full Screen

This entry allows a monitor to be used for full-screen view (without Navigation Pane,
menus, etc.)

· Monitor List
If this ControlCenter has more than one monitor, then a list of monitor’s numbers is
shown. You can check which of the listed monitors are to use full-screen mode (in other
words, the checked monitors only show the viewing pane with its viewing tiles, and they
do not show the Explorer and Workspace panes. 

· Selected Tile, Layout
Select whether full-screen view is to be only the selected tile or all tiles in the viewing
pane.

· F11 to toggle full screen – in addition to the entry in the View menu, the user can use
the F11 key at any time to toggle the current Viewing Pane to normal or full-screen
mode.

4.4 Adaptive Streaming
Adaptive Streaming saves bandwidth and enhances system performance by tailoring a
video stream's resolution to the size of the viewing tile. The system displays high-resolution
images when the image is shown in larger tiles or full-screen mode. When shown in smaller
tiles, not so much resolution is needed, so the stream can be reduced. 

By default, Adaptive Streaming is enabled in each ControlCenter client. To disable Adaptive
Streaming for a ControlCenter, go to Tools/Options/Video and deselect the Adaptive
Streaming check-box.

To disable Adaptive Streaming for a given camera, right-click the tile in which it is displayed
and deselect Adaptive Streaming.

Adaptive Streaming is currently available with the Ariel, Quasar, and Quasar Gen 2 edge
devices by Flir.
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5 Common Tasks
Viewing live Video/Audio

To view a camera on a viewing tile:

Digital PTZ using the mouse

Draw-to-Zoom

Digital Zoom Indication

Playing Live Audio

Managing the Workspace

Move a video from one tile to another

Remove a video from a tile

Using one tile for the content you request - Spot Monitor option.

Using the Layout Pane to change the pattern of the Viewing Tiles

Maximizing the Navigation tree

Aspect Ratio

Playback for Media

From Query Results pane

Check for recordings from a camera currently being displayed ‘live’ - ‘Send to Query’

Using Instant Replay (IR)

Controlling the Playback using the Viewing Tile Toolbar

How to use all the controls in the Timeline tab

Timeline Tab Toolbar

Time Ruler

Tracks

How to create a Bookmark on a clip

Using the Bookmark Filter

Synchronizing multiple sources (Synchronized playback)

Loop playback

Locking clips (or segments of clips)

Locking clips from the Query Pane

Locking clips from the Timeline

Find and cancel a Locked section in a clip

Exporting

Export from Query Pane

Export from Timeline

5.1 Viewing live Video/Audio
To view a camera on a viewing tile:

Digital PTZ using the mouse

Digital PTZ using Draw-to-Zoom

Playing Live Audio
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5.1.1 To view a camera on a viewing tile

· Click-and-drag it from the Navigation pane onto a Viewing tile

or

· double-click it in the Navigation pane and plays in the next available tile

· right-click it in the Navigation pane, and then select Display and it plays in the next
available tile

If audio streams are attached to a camera, they play.

5.1.2 Digital PTZ using the mouse

While viewing any video (Live or Playback), the ControlCenter allows you to zoom into the
image to see more detail. 

1. Left click the tile of the video you would like to zoom.

2. Put the mouse on the tile you wish to zoom, and click the mouse wheel once. 
3. The cursor changes to a green arrow outline – this means the Digital Zoom feature is enabled.
4. Roll the wheel forward to zoom into the picture. Digital Zoom Indication shows that Zoom is being

used. 
5. Once you have zoomed in, you can move the mouse up, down, left, right or diagonally, and a

corresponding arrow is shown. Click the mouse again and the picture moves in the direction of the
arrow.

6. Zoom out by rolling the mouse wheel towards you.
7. To return to normal viewing for the tile, Right-click in the tile, and select Reset Digital zoom.
8. Clicking on the mouse wheel again returns the mouse to normal operation.

5.1.3 Draw-to-Zoom

For fixed cameras, a Magnify icon  ,  allows the user to use the mouse to draw a
rectangle around the area to be viewed.
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Click Magnify icon Select area Zoomed image

After clicking the Magnify icon, use the mouse to click-and-drag the area you wish to
magnify. 

To return the tile to normal display, right-click to open the Context menu, and select Reset
digital zoom.

5.1.4 Digital Zoom Indication

When Digital Zoom is in use (either using the mouse or draw-to-zoom), a Magnify icon
and a thumbnail showing the zoomed area in relation to the whole scene are shown.

5.1.5 Playing Live Audio
Note: Only available when connected to a Latitude system

Drag and drop the microphone onto a tile layout.  

Figure 20 - Playing Audio in a regular tile

You can use the audio controls in the tile to Start Recording, Start Instant Replay, Mute
the sound and Control the Volume.
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5.2 Timeline Pane
The Timeline Pane allows the user to control the playback  window.

Figure 21  - Timeline - Key Components

· Toolbar – Buttons for Timeline display options
 – See detailed description Timeline Tab Toolbar  

· Playback Controls – Normal Rewind, Play, Pause, etc.
· Date and Time – Shows the exact Time and date of the scene that is currently being

played
· Playback Speed – Indicates the mode of playback 
· Time Ruler – Shows how much time is covered in the Timeline window. This can be varied

using the Scale Tool (see below)
· Scroll Control – Clicking the double arrows allows you to move the part of the clip

displayed in the Timeline window earlier or later
· Scale Tool – Placing the mouse on the Time ruler lets you compress or expand the

Timeline scale (to show more detail or more time in the window)
· Bookmark – Symbols show you each place where the clip contains a bookmark
· All Recordings track - Shows you all recordings for the camera named in the title bar of

the Timeline
· Clips – the bars in the All Recordings track show the times during which recordings exist

for this camera
Note: The red areas in clips show the time during which motion was detected. The
level of red indicates the amount of motion detected. 

· Timeline Cursor – shows the point in the clip which is currently being played
· Workspace Tabs – Allow you to call up other Workspace Tabs. 

(You can return to the Timeline by clicking on the Timeline icon .)

5.3 Managing the Workspace
Move a video from one tile to another

Remove a video from a tile

Using one tile for the content you request - Spot Monitor option.

Using the Layout Pane to change the pattern of the Viewing Tiles

How to add or modify a Layout

Using Customized Layouts

Maximizing the Navigation tree

Aspect Ratio
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5.3.1 Move a video from one tile to another

Click the video to be moved, and drag to the destination tile.

Figure 22 - Click and Drag Video to another tile

5.3.2 Remove a video from a tile
1. Click the video to be removed, and drag it anywhere out of the Viewing Pane.

Figure 23 - Click and drag a video out of the Viewing Pane

-or-
2. Right- Click the video and select Remove. 

5.3.3 Using the Layout Pane to change the pattern of the Viewing
Tiles

The layout pane gives the user a comprehensive set of choices of patterns for how to
arrange viewing tiles in a layout. These range from the simple 4-tile default layout, through
multiple matrix layouts that show up to 32 simple rectangular tiles, various mixes of large
and small tiles that allow some areas to be shown in large tiles with others on the edges for
monitoring, to specialized patterns that cater for wide-angle views such as are used by
‘stitched’ scenes.

Clicking on any of the patterns in the layout pane changes the viewing pane arrangement to
the selected pattern. Tiles are re-arranged, with each tile from the old pattern being
displayed in the tile with the corresponding tile number in the new pattern. 
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5.3.3.1 Using one tile for the content you request - Spot Monitor
option.

Spot Monitor enables the user to designate a specific tile to be used whenever a scene
double-clicked, regardless of the current Active Tile.  

Spot Monitor is useful if you want to always look for the results of a double-click in the same
place.

To enable the Spot Monitor, right-click the desired tile in the Tiles pane, and then select 
Spot Monitor. Once a tile is selected as spot monitor, its edge is marked red.

Figure 24 -  Designating a Spot Monitor tile
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5.3.4 How to add or modify a Layout

1. If a new Layout is needed, click the Add Layout icon in the Viewing Pane Toolbar.
2. Name the new Layout and click Save.
3. Switch to the layout you would like to modify by clicking its tab at the top of the Viewing pane or

double-clicking its icon in the Navigation pane.
4. Select a tile pattern by clicking one of the tile pattern buttons in the Tile Layouts pane (on the

right of the Viewing pane).
5. Drag the logical entities (cameras, sequences, maps, etc.) that you want to show from the

Navigation tree to the required Viewing Tiles.
If required, arm the viewing tiles for alternative content or alarms as desired.

5.3.5 Using Customized Layouts

When adding a customized workspace to the Favorites, the order, visibility and size of the
different panes, the open layouts (multiple systems) and the open tiles (allowing tiles from
multiple systems) are saved.

The user can therefore create the mode of choice by selecting the desired panes in the
workspace.

To add a customized layout to your Favorites Mode:

When adding a customized workspace to the Favorites, the order, visibility and size of the
different panes, as well as the open layouts (multiple systems) and the open tiles (allowing
tiles from multiple systems) are saved.

Therefore, before creating the mode of your choice select the desired panes in your
workspace.
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1. Access the sidebar by hovering over the faint outline in the left border of your workspace until a
solid arrow appears.

2. Click the arrow to expand the sidebar.

3. Expand the drop-down menu of the Favorites mode, and then select Save layout as favorite.

To access a customized layout:

1. Access the sidebar by hovering over the faint outline in the left border of your workspace until a
solid arrow appears.

2.  Click the arrow to expand the sidebar. 

3. Expand the drop-down menu of the Favorites mode, and then select the desired layout.

To Select patterns available in the layout pane:

There are many possible Layout Patterns in the system (currently over 30). If you want to
show a smaller number so that it is easier to choose, you can set which patterns are
available by selecting View Settings/Layout Patterns from the Tools/Options menu, and
then using the left and right arrows move patterns between the Available and Selected
lists, so that only those Layout patterns that you wish to have displayed are in the Selected
list.

 You can also click a pattern symbol in the Selected list to select it, and use the up and
down arrows to re-order it in the sequence of Layout patterns.

Figure 25 - Selecting Layout Patterns to be available

Tile Border

When the tile has a colored border, it indicates that the tile is currently designated for a
particular purpose. 

Border Tile Status

Yellow The tile is focused. You must focus a tile in order to expand it to fill the viewing
pane or to use digital zoom or PTZ controls on its video content. Only one tile
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Border Tile Status

can be focused at any given time. A tile turns focused when it is clicked or when
new unarmed content is dropped onto it.

Green The tile is one of several selected tiles. A focused tile becomes selected when
another tile is control-clicked (thus becoming focused itself). 
Selection is only meaningful when trying to apply an action to multiple tiles. The
most common uses for this is when bookmarking or trashing multiple tiles at the
same time.

Red The border of a tile's viewing area turns blinking red when content for which it
has been armed begins playing. The border disappears as soon as the tile is
clicked. Multiple tiles can be playing alarm-related content at the same time.

5.3.6 Maximizing the Navigation tree

You can maximize the Navigation Tree pane by using the push bar. This is especially
useful for the Navigation tree when you are dealing with a large installation.

Figure 26 - Using the Push bar to maximize the Navigation tree
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5.3.7 Aspect Ratio

When a video image is displayed, the system default is to maintain the aspect ratio in order
show the most accurate video.  Where the proportions of the viewing tile differ from those
of the video displayed therein,  the system inserts black bars in the unused portions of the
tile.

When the aspect ratio is not maintained, the video stretches to fill the viewing tile.  

Set ControlCenter to Maintain or Ignore Aspect Ratio
The aspect ratio setting for a ControlCenter is set in the Tools/Options/Video screen.  By
default, this is set to Maintain aspect ratio, but you can uncheck this option.

Toggle Aspect Ratio in a Viewing tile
To toggle the aspect ratio in a single viewing title, highlight that tile and press SHIFT+R.

When Maintain aspect ratio is checked, the
display is shown with 'frames' to fill the

unoccupied portions of the tile.

When Maintain aspect ratio is unchecked, the
display is stretched to fill the available tile.

5.4 Viewing recorded Video
From the Query Pane
From Query Results pane
Check for recordings from a camera currently being displayed ‘live’ - ‘Send to Query’
Using Instant Replay (IR)
Controlling the Playback using the Viewing Tile Toolbar
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5.4.1 By selecting a camera from the Query pane

· Click-and-drag it from the Query pane onto a Viewing tile

5.4.2 From Query Results pane

Figure 27 - Playback from the Query Results pane

To play a clip from the Query Results Pane:

1. Open the Query Pane by clicking on the Query Pane Icon  in the Explorer pane
2. Select the camera from which you want to play a clip
3. Run the Query
4. From the Query Results window, pick the clip you want to run, and either double click it to play it in
the next available viewing tile, or drag-and-drop it to the viewing tile in which you want to view it.
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5.4.3 Check for recordings from live camera

While a camera is being displayed live in a viewing tile, you can quickly list any stored
recordings for that camera. 
1. Right-click in the live video tile to open the Context Menu, and select ‘Send to Query’ 

The Query window opens automatically with the current camera and the default Time
and Date range already selected (‘Last 24 hours’).  

Figure 28 - 'Send to Query' from a live video tile

2. You can modify the search parameters if required.
3. Click ‘Go’ to execute the Query. Results are shown in the Query Results Pane.
4. Click any line in the results pane to show the recording in the 'next available' Viewing tile.

5.4.4 Using Instant Replay (IR)

Note: In order to use Instant Replay, at least one tile should be set to play Alternate
Content.

In a tile showing live video content, you can click the Instant Replay button in the Live
Viewing Toolbar at any time, and a replay delayed by 30 seconds appears in the next
available tile. (Provided the tile is being recorded i.e. the Tile status shows Recording). 

Figure 29 - Start Instant Replay from Live Viewing Tile

The 30 second replay is a standard function, that allows you to quickly call up a replay if
you noticed something in the live window and you want a quick second look.

Note: The IR button is a very convenient way to review material in a Live/Recording
Tile. Clicking IR starts Replay and opens the Timeline for the tile, and then you can
use the Scroll Controls to move to the earlier parts of the recording (see ‘Send to
Query’ above).
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5.4.5 Controlling the Playback using the Viewing Tile Toolbar

When playing a video clip, the Viewing Tile Toolbar contains control buttons for rewinding,
Play/Pause and fast-forwarding the clip. 

Figure 30 – Playback Tile Toolbar

5.4.6 Using Thumbnail Search

Thumbnail search allows users to view still images ("thumbnails") taken at regular intervals
from a recorded video.  The feature provides an additional way to pinpoint an event.

5.4.7 How to use all the controls in the Timeline tab

The Timeline Tab allows you to control all aspects of Playback. 

Figure 31 - Timeline Components

The following paragraphs describe the Timeline Tab components in detail.
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5.4.7.1 Timeline Tab Toolbar

Figure 32 - Timeline Toolbar

The Timeline Tab Toolbar gives the following capabilities.

Table 2- Timeline Tab Toolbar

Icon Label/Name Description

Expand/Collapse
Tracks

Toggles the track views between displaying only Recordings and
Bookmarks and displaying All. See Tracks.

Reposition current 
frame position

If the Timeline Cursor is not visible (i.e. if you have moved the clip
either with the Timeline Scroll Controls or with the Scaling control), this
button repositions the clip so that timeline cursor (playhead) is
centered in the window.

Lock (Enabled only when you have marked a clip by clicking and dragging
the mouse while it is in the Timeline Tracks area, or with the
MarkIn/MarkOut buttons) 
Note: Once you have locked a segment, you can only unlock it from
the Clip Query results window.  

Export Opens the Export pane and loads the marked range of the timeline. 

Hide/Show Motion Hides or shows motion markings of the video on the timeline (toggle)

Jump to specific
time 

Opens the Jump to dialog on the right of the timeline for entering a
time/date which you want the playhead to go to.

Bookmark Filter Enter text to filter which Bookmarks are to be displayed.
See Using the Bookmark Filter

Mark In/Mark Out Use to mark a section of a clip so that it can be locked or exported. 
A marked section is shown with this symbol   
You can also mark a section of a clip by ‘click and drag’ with the
mouse in a track.

Cancel marked Use to cancel the Marked Section 
Note: Cancels only while the ‘marked’ symbol 

 is showing – once Locked, you must use the Query Search
function to cancel. 
See Find and cancel a Locked section in a clip

Play Controls

Rewind, Pause, Play, FFWD, SlowFWD Icons.
Each click of the FRewind or FFWD icons changes the playback
speed. 
Speed increments are +/- x 1, 2, 4, 8, 16, 32, 64

Date, Time Exact date/Time of the playback (at the playback cursor position)

Playback Speed Current Playback Speed setting

Prev/Next
Bookmark

Jump to the previous or next Bookmark in the current track

Create Bookmark Create a Bookmark at the current Timeline Cursor position
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5.4.7.2 Time Ruler

Icon Name Description

 
ScrollBack/For

ward
Click with the mouse to scroll the contents of the Timeline window
backwards or forwards

TimeRuler Shows the scale of the current Timeline window . 
Note: You can adjust (compress/expand) the scale.
Put the mouse on the Time ruler (it changes to the 

  symbol)
Click and Drag - left (expands), right (compresses)

5.4.7.3 Tracks

The default Timeline display only shows the Bookmark and Clip Timeline tracks.

Figure 33 - Default Timeline showing Bookmark and Clip Timeline tracks

By clicking on the Expand tracks icon  in the Timeline Toolbar, you can show/hide
more detail about the clip being replayed.

Figure 34 - Detailed Timeline showing additional information tracks

Table 3 - Timeline Track Icons

Icon Track Description
Bookmarks All bookmarks for any of the displayed clips are shown 

All
Recordings

track

The green bar shows times during with there are recordings for this camera.
Note: If ‘show motion’ is ON, then the red areas in the bar show times during
which the System registered that there is movement on the camera. 

Manual Indicates time during which recordings are made as a result of the user manually
clicking ‘Record’ (manual recording)

Schedule Time during which recordings are made as a result of a Schedule

Event Times during which Events are associated with this camera

Alarm Times during which alarms are associated with this camera
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Icon Track Description
Edge

recording
Times where content was recorded by the edge device and subsequently loaded
into the system

Protected Segment of the clip that has been Locked 
Note: A locked clip can only be unlocked by finding it in the Query Results Pane
and unlocking it there

5.4.8 How to create a Bookmark on a clip

Bookmarks are a convenient way to mark a point in a clip – this may be done automatically,
for example by the AdminCenter setting up an Action to create a bookmark whenever
motion is detected. 

However, a ControlCenter user may want to insert a bookmark while reviewing a clip. The
following steps are needed:
1. Click the Viewing Tile that is playing the clip. This makes it the Active tile, and the Timeline is

displayed in the Workspace pane. 
2. Position the Timeline cursor at the point where you want the bookmark. (If you want to pause the

playback so that the bookmark is at an exact point, click the Pause icon ) 

1. Click the Create Bookmark icon .  



60
May 17, 2017

Common Tasks

United VMS 8.0 Control Center User Guide

2. A Bookmark is shown at the current Timeline position. 
The Bookmark dialog box opens. Add/change the description if necessary, and click Save.

Remember that you can perform Queries on the text in the Bookmark, so it is useful
to use text that helps you to find the bookmark later, if required.

5.4.9 Using the Bookmark Filter

When you enter text in the Bookmark Filter box, the clips for the current camera are all
displayed, but only the bookmarks which contain the text in the Bookmark Filter field
appear. You can then use the Previous and Next icons to move through the clips for the
current camera to see which of the matching bookmark are of interest.

5.4.10 Synchronizing multiple sources (Synchronized playback)

The system allows you to view synchronized recordings from several cameras at the same
time. If multiple cameras record something of interest – say, two people moving across
their field of view and you want to watch what happened. 

6:07:55.54 6:07:59.75 6:08:00.20 6:08:01.00

Figure 35  - Synchronized View – watching more than one camera

You can do a clip search, specifying more than one camera, and
then click ‘Sync’ – the system searches for all clips for those
cameras in the specified time range. 

ControlCenter opens a special ‘Synchronized Playback’ layout ( 
 ), and a Timeline pane with a timeline

track for each of the selected cameras. This shows any clips
from the selected entities.

Figure 36  Timeline showing Synchronized Playback
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5.4.11 Loop playback

To play a portion of a recorded clip as a repeated loop:

· Find the part of the clip that should be played

· Click and drag on the timeline to mark the start and end of the required loop

Alternatively, you can position the Timeline Cursor at the required points, and use the Mark
In/Mark Out buttons
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· Right-Click to display the context menu, and select Start Loop Playback

· To stop the continuous playing of the clip, right-click the desired section and select 
Stop Loop Playback

The same method can be used while reviewing exported clips.

5.4.12 Locking clips (or segments of clips)

Locking Clips from the Query Pane

Clips may be locked from the Query pane simply by selecting a clip and clicking on the

Lock icon  . 

The clip entity icon changes to show that the clip is locked.

Figure 37 - Locking a Clip from the Query Pane

Clip is Unlocked – 
Click the Lock icon to Lock it

Clip is Locked – 
Click the Lock icon to Unlock it



May 17, 2017
63

Common Tasks

United VMS 8.0 Control Center User Guide

Locking Clips from the Timeline

Alternatively, segments of a clip can be locked by marking them in the Timeline window
and then Locking them.
1. Mark the start of the segment.

1. Position the mouse where the segment
should start OR

1. Position Timeline Cursor where the
segment should start, and click Mark in

2. Click-and-drag the mouse through the
desired time in the Timeline tracks

2. Move the Timeline Cursor to where the
segment should end, and click MarkOut

2. The system indicates the marked segment.

A mouse-over on the segment indicator shows the exact start and end times of the
segment.
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Lock the segment by Right-clicking and selecting
Lock in the Context Menu

Click the Lock icon in the Timeline Toolbar
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5.4.13 Find and cancel a Locked section in a clip

To unlock a clip from the Query pane, simply select it. When the selected clip is locked,
the Lock icon changes to show that it can be unlocked, and clicking the Lock icon again
unlocks the clip (see Locking Clips from the Query Pane). 

When a Clip was locked from the Timeline, it cannot be unlocked from there, and you have
to perform a search so that it is once again displayed in the Query Results pane.

To narrow down the search, you can select only the camera which recorded the clip and
use the time parameters. To further reduce the number of results, you may wish to use the 
Advanced Search capability, and restrict the search to clips that are ‘locked’.

Figure 38 - Using Advanced Query to find a Locked Clip
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5.5 Taking a snapshot from a Viewing Tile
You can take a snapshot of video that is being displayed in a viewing tile (Live or Playback),
simply by right-clicking in the Tile, and selecting ‘Take snapshot’ from the context menu
that appears.

Figure 39 - Taking a snapshot

The resulting picture is stored in the location set in Main Menu/Options/Export/
...Snapshot.

5.6 Exporting

Exporting from Query Pane

1. Perform a query to find the clip that you would like to export.

2. Select the desired clip, and then click .
The Export Settings dialog appears in the Query Results pane.

3. The file name and export location are set by default. Enter changes if required, and whether to
create a new folder for the file to be exported. 
    The defaults are defined in the Tools/Options/Export/Clip menu.
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Figure 40 - Export - Default Settings (See c)

4. If you need to use non-default export parameters, click Advanced.
    The Advanced Export Settings dialog box appears.

Figure 41 - Export - Advanced Settings

5. Set the desired parameters:
· Create autorun file - Select this check box to create an autorun file for all exported files

to automatically run the files after they are burnt on a disk.
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· Include player - Select this check box to automatically export and burn copy of the
Quick ControlCenter along with exported files that are burnt on a disk.

· Clip Segment - The duration of the exported clip.
· Format - DVT, MP4 or AVI – Determines clip format of the audio and video clips.

The FLIR .dvt format is the default. The integrity of files exported in this format can be
authenticated. 
If a clip must be exported in a format that can be read by other systems, then the option
can be unchecked, and the file is exported in the format selected from the drop-down.

Note on Export Settings:

i. Default output format is .DVT

ii. If the default .DVT format is deselected and no format selection is made, the
Video/Audio codec selection fields are enabled and the User can manually select the
Video and Audio codecs to be used.

iii. Interleaved Export (File contains video and audio) is only available in .DVT files.

iv. .MP4 can only be used for video content that originated in H264 format. 

v. OSD and Privacy Masks are not supported in MP4 exports. Clips with associated
OSDs will be exported without the OSD. Clips with Privacy Masks may not be exported
in .MP4 format..   

· Interleaved Export - Select this check box to export interleaved audio and video clips.
This option is enabled only when the .avi format is selected.

Note: For high-quality output, it is recommended to use the xvid codec. If you install
the xvid codec, please contact support for instructions on how to update the system
to be able to use this format

Figure 42 - Export - Selecting a Video codec

6. Click OK.
The clip is exported to the defined location.

Exporting from Timeline

1. While playing a clip, mark the desired section in the Timeline by click-and dragging the mouse on
the Recording track for the length of the required export. The area is marked 

. Otherwise, you can use the MarkIn/MarkOut buttons 

. 

2. On the Timeline toolbar, click the   button or right- click the desired section and select
Export.

3. The Export Settings dialog box appears in the Timeline pane.
4. Set the file name, export location and whether to create a new folder for the file to be exported. If

you do not fill in the fields, the system uses the parameters defined in the Export Clip Options
menu.

5. To set additional export parameters, click Advanced.
6. The Advanced Export Settings dialog box appears.
7. Set the desired parameters (see Steps 3) to 5) in Export from Query Pane above).
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8. Click OK.
The clip is exported to the defined location.

5.7 Alarm management
How to handle alarms

Handling alarms from the PopUp

Handling an Alarm from the tile that is displaying it

Handling alarms from the Alarms Pane

How to trigger alarm manually

How to trigger alarm manually

5.7.1 How to handle alarms

Normally, when an alarm is triggered, it displays the camera/s associated with that alarm, in
the tile/s that are ‘Armed for alarms’, and you can manage the alarm using the controls in
the tile displaying the alarm. 

If the new alarm is of a lower priority than one currently being displayed, it is not displayed
until the higher-priority alarm has been addressed. 

Handling alarms from the PopUp

Handling an Alarm from the tile that is displaying it

Handling alarms from the Alarms Pane

5.7.1.1 Handling alarms from the Popup

The Alarm PopUp alerts you that an alarm has been triggered and you are listed as a
recipient – that is, you are one of the ControlCenter users who are able to handle this type
of alarm.

To Display the Alarm in the Next Available (unarmed) Tile

You can use the icons in the Alarm PopUp to perform the following functions:
1. Click the Alarm text 

OR

2. Click the Display icon  

To Clear an Alarm

Click the Clear icon  

To Snooze the Alarm

Click the Snooze icon 

To Move to the Previous or Next Undisplayed Alarm
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Click the Prev/Next arrows  

5.7.1.2 Handling an Alarm from the tile that is displaying it

Once an Alarm is being displayed in a Viewing Tile, you can use the controls in the Viewing
Tile Toolbar to handle the alarm.

Figure 43 - Alarm displayed in Viewing Tile

To Accept an Alarm Directly

Click the  button. 

Accepting an alarm means that you are taking responsibility for handling it – it is no longer
shown to other recipients.

To Snooze an Alarm Directly from the Tile Displaying It

Click the  button

To Clear an Alarm Directly from the Tile Displaying It

Click the  button
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5.7.1.3 Handling alarms from the Alarms Pane

You can click the Alarms Pane Tab, and use the icons in the Alarms Pane Toolbar to
handle alarms in that pane. 

Figure 44 - Handling alarms in the Alarms Pane

To Display the Alarm in the Next Available (Unarmed) Tile:

Double-click the entry in the table.

To Accept the Alarm:

Click the  button.

To Forward an Alarm:

Click the  button.

Select the person to whom it must be forwarded from the list of users that is presented.

To Snooze the Alarm:

Click the  button.

To Show a Procedure for the Alarm:

Click the  button.

To Clear the Alarm:

Click the  button.

5.7.2 How to trigger alarm manually
1. Open the Alarms tab by clicking on the Alarms Tab Icon.

2. Click the Trigger an Alarm button. 

3. The Alarm Trigger dialog window opens.
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Figure 45 - Manual Alarm Trigger Dialog

4. Select the required alarm from the Alarm types tree
5. Add Description if required
6. Click Activate

5.8 How to use the file playback pane
The File Playback pane allows you to select files and folders that have been stored on the
system, then add them to the File Playback list. From there, they may be played in the
same way as files are played from the Query Results pane.

5.8.1 Adding clip/s or folders
1. Click the File Playback icon to open the pane.
2. Use the Toolbar icons Add Clip 

 and/or Add Folder 

 to open a File Selection window from which you can select content to be added to the
list.

Figure 46 - File Playback - Folder/File Select window

3. Add folders and/or files (clips) by selecting them and clicking Open.
The selected clips are added to the File Playback list.
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Figure 47 - File Playback List

5.8.2 Authentication

Files which were exported using the .dvt or .avi format contain checksum information to be
able to prove their integrity. You can validate that a file is unmodified by selecting it in the

File Playback list and clicking the Validate icon .

5.8.3 Play single

To play a single item in the File Playback list, select it and click the Play icon .

5.9 How to login to additional systems
A ControlCenter can be connected to multiple systems running on Latitude, Horizon
and/or Meridian platforms.

If you have a user name and password for more than one system, you can log in to
additional systems and view all the entities and perform all actions for which you
have authorization.

To log into another system, go to the Main Menu and click File/System/Connect 

Note: Some features are only available when connected to Latitude systems.
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Figure 48 - ControlCenter - Login to an additional System

The system opens a Login window, and you can enter a user name and password to
connect to another system.

When your user name and password are accepted, your Navigation Tree shows the
additional system.
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Figure 49 - ControlCenter connected to a 2nd system
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5.10 Using Keyboards
Either a CCTV keyboard or the typical PC keyboard can be used to perform many
ControlCenter tasks.

The System Details area of the Viewing Pane Toolbar shows details of the current
ControlCenter, and displays parameters entered by the user when using a keyboard. 

Figure 50  - System Details area of the Viewing Pane Toolbar

All entities (cameras, camera sequences, tiles, layouts, monitors, etc.) have a unique ID
represented by a logical number. The ID is shown as a number in parentheses (n) in the
Navigation tree.

Figure 51 - Entity IDs in the Navigation Tree – Examples

In order to display a camera in particular viewing tile, the user first sets up the required
Layout, chooses the required Active tile, and then selects the required entity to be
displayed in that tile.

5.10.1 CCTV Keyboard

Using the CCTV keyboard, you can control the ControlCenter application (both local and
remote). 

The following tables list the CCTV keyboard commands supported by the system.
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5.10.1.1 Selecting and Controlling Entities and Tiles

All entities (cameras, camera sequences, tiles, layouts, monitors, etc.) have a unique ID
represented by a logical number (xxxx).

Function Command

Select an analog monitor or
ControlCenter viewing pane

Monitor number and MON

Select a viewing tile Monitor number and MON

Display a camera on the selected
monitor or tile

Camera number and CAM

Toggle through viewing pane
layouts with 4-8 tiles

2x2

Toggle through viewing pane
layouts with 9-13 tiles

3x3

Toggle through viewing pane
layouts with 16 tiles

4x4

Expand currently selected tile to
fill viewing pane

MON

Clear currently selected tile or
analog monitor

CLEAR

Clear contents of the keyboard
screen’s ENTER field

CLEAR

Display a sequence on the
selected monitor or tile

Sequence number and SEQ

Display a sequence on the
selected monitor or tile

Press SEQ twice

Hold a sequence NEXT

Switch to the next camera of a
paused sequence

LAST

Display an instant replay on the
selected analog monitor (not
available on a viewing tile when
using the keyboard)

INST. REPLAY (See additional table for more
instant replay controls)

Bookmark the selected file BOOKMARK

Turn recording of the selected
camera’s video stream on/off

RECORD ON/OFF

Trigger an alarm Alarm number and ALARM
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Function Command

Acknowledge an alarm in its
active tile

ACK

5.10.1.2 Controlling Playbacks

Following are the CCTV keyboard commands used to control playbacks:

Function Command

Play IRIS OPEN

Pause IRIS CLOSE

Rewind FOCUS NEAR or joystick left

Fast Forward FOCUS FAR or joystick right

Increase playback speed IRIS OPEN

Decrease playback speed AUX ON

5.10.1.3 Controlling PTZ Domes

 Following are the CCTV keyboard commands used to control PTZ domes:

Function Command

Pan left/right Joystick left/right

Tilt up/down Joystick up/down

Zoom in/out Twist joystick clockwise/counter-
clockwise

Call a dome preset Preset number and PRESET

Call a dome pattern Pattern number and PATTERN

Send a dome to its home
position

HOME

Lock/unlock a dome LOCK

Flip a dome’s position FLIP

Control a dome’s iris Press and hold IRIS OPEN or IRIS
CLOSE

Focus a dome Press and hold FOCUS FAR or FOCUS
NEAR

Utilize a dome’s auxiliary
controls

Aux number and AUX ON or AUX OFF
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5.10.2 PC QWERTY Keyboard

Note: The keypad NUM LOCK must be on for the following commands.

Following are the PC keyboard commands used to select entities and tiles by their
IDs:

 Function Command Function Command

Select monitor or tile
xxxx 

xxxx and keypad ‘.’ Pan left Shift and Left
arrow

Select camera or
layout xxxx

xxxx and keypad ENTER Pan right Shift and Right
arrow

Select camera
sequence xxxx

xxxx and CTRL and keypad
ENTER

Tilt up Shift and Up
arrow

Select system xxxx xxxx and M Tilt down Shift and Down
arrow

Clear led display ESC Zoom in Shift and keypad
‘/’

Selected tile - 
Arm/disarm toggle

A Zoom out Shift and ‘*’

Selected tile -
Expand/collapse
toggle

keypad ‘.’ Decrease PTZ
speed

Shift and keypad
‘-’

Remove displayed
entity

Backspace Increase PTZ
speed

Shift and keypad
‘+’

Camera - Add
bookmark

B Go to preset xxxx and Shift
and Insert

Camera - Start/stop
recording

R Set preset xxxx and CTRL
and Insert

Camera - Talk (push-
to-talk)

, (comma) Run pattern xxxx and Shift
and Home

Camera -Listen
(on/off)

. (period) Record pattern
(start/stop)

xxxx and CTRL
and Home

Camera sequence -
Start/stop

CTRL and Up arrow Auxiliary On xxxx and Shift
and Page up

Camera sequence -
next camera

CTRL and Right arrow Auxiliary Off xxxx and Shift
and Page up

Camera sequence -
next camera

CTRL and Left arrow Open iris Shift and Delete

Trigger alarm xxxx and CTRL and A Close Iris CTRL and Delete
Acknowledge alarm on
selected tile

CTRL and Space Focus near Shift and End

Instant Replay on
selected tile

I Focus far CTRL and End

Play/Pause G Lock Shift and L
Rewind K Go Home Shift and H
Fast Forward L Flip Shift and F
Increase playback
speed

Shift and keypad ‘+’

Decrease playback
speed

Shift and keypad ‘-’
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6 Case Builder
CaseBuilder allows authorized users to collect and organize data in a case, review it, and
prepare it on portable media to be taken to off-site investigations or to a court of law.  

CaseBuilder is only available when connected to Latitude Systems.  

Note: In order to work with the CaseBuilder application, a licensed CaseBuilder server has
to be defined in the AdminCenter. See the Help file for information about the CaseBuilder
server configuration.

To access all CaseBuilder related panes in one click, access the ControlCenter sidebar
and select the CaseBuilder mode. The CaseBuilder mode displays a workspace containing
all necessary panes.

Figure 52 - CaseBuilder Layout

6.1 Creating a new case
There are several ways to start a new case. You can start by querying a clip that should be
added to a case and then continue adding content. Alternatively, you can start out by
creating a case and then adding content to it.

An important thing to remember when working with CaseBuilder is that you can only have
ONE Case open at a time. The CaseBuilder Navigation Tree is not for moving through all
your Cases - it is only there to let you build the current case. When you are finished, you 
Save the Case and Export it. You can re-open a saved case and add to it –  this is
discussed below.
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6.1.1 How to add a Clip to the current case

From the Query window, select the clip that you want to add to the case, and click the 
Add to Case button  in the Query results Toolbar. The clip is added to the current Case,
and it appears in the CaseBuilder Navigation pane. 
A CaseBuilder Layout tab automatically appears in the Viewing pane.

Note: The Add to Case button is only enabled if CaseBuilder is configured as part of
the system.

6.2 Adding a segment of a clip to the case
1. In the Query Results Pane, double-click the clip from which you want to add a segment. 

2. Once the clip starts playing in the Viewing pane, select the desired segment in the Timeline pane
by clicking-and-dragging the mouse through the desired part of the clip in its track. 

3. Right-click the segment and select Add to Case.

6.3 How to add a file to the current case
1. In the CaseBuilder Navigation Tree Toolbar, click the Add drop-down and select Add File.

The CaseBuilder File dialog window opens.

Figure 53 - CaseBuilder File dialog window

2. Select the required file and click Open. 
The file is added to the Case and appears in the CaseBuilder Navigation window.

6.4 Add a URL to the current Case
1. In the CaseBuilder Navigation Tree Toolbar, click the Add drop-down and select Add URL.

The Add URL Dialog box opens.



82
May 17, 2017

Case Builder

United VMS 8.0 Control Center User Guide

2. Enter the URL and click OK.
The URL is added to the Case

Figure 54 - CaseBuilder Navigation Tree showing Clips, a File and a URL
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7 Additional Technical Information
Table of Navigation Tree Icons

Viewing Tile Action Buttons

Tools Options Menu

Remote Control Options

Alarm Display Mode 

7.1 Table of Navigation Tree Icons
The Navigation Tree shows the status for each entity, using a set of detailed icons.

Thus, the standard icon for a Camera is 

.  Other entity icons include PTZ cameras 

, Cameras with linked audio 

, Microphones 

 and so on. 

To show different conditions, the icon can be shown with additional information, such as a
red dot to indicate Recording 

, or a ‘no entry’ sign to show that it is ‘Inaccessible’ 

. 

There are also  icons representing camera sequences 

 and composite scene tracker 

 views. These can also be dragged to viewing tiles so that you
can monitor them.

The Navigation tree always shows the logical structure that entities belong to – so you
can see which system 

 they are connected to, and which Enterprise 

 and site 

 within each system, if these have been defined.

The table below shows all the basic symbols, each with their possible variations. 

Table 4- Navigation Tree Entity Types and Statuses

Icon Description Status Comments

Camera

Camera  OK

    Not
accessible

   Lost Video
Signal

    Camera,
Recording 

OK,
Recording
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Icon Description Status Comments

    Video
and/or
Recording
failed

Possible loss of video signal or recording
problems with Archiver

Camera
with linked
audio  

OK

    Not
accessible

    Lost Video
Signal

Camera
with linked
audio,
Recording  

Camera OK

Recording
OK

    Video
and/or
Recording
Failed

Possible loss of video signal or recording
problems with Archiver

PTZ
Camera  

OK

PTZ
enabled

    Not
accessible

    Lost Video
Signal

    OK,
Recording

    Video
and/or
Recording
Failed

Possible loss of video signal or recording
problems with Archiver

PTZ
Camera
with linked
audio  

OK

    Not
Accessible

    Lost Video
Signal

PTZ
Camera
with linked
audio  

Camera OK

Recording
OK
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Icon Description Status Comments

    Video
and/or
Recording
Failed

Possible loss of video signal or recording
problems with Archiver

Serial Device

Serial Port OK

    Not
Accessible

User

User 

Input Pin
Device

Input Pin 

(alarm
input)

OK A external device, for example an alarm
system, wired to an edge device input, (e.g.
encoder, camera or matrix.) 

     Not
Accessible

Likely the edge device or connection that the
input is wired to is not accessible or
unresponsive

Output Pin
Device

Output Pin

(relay
output)

OK A external circuit, for example a door lock,
wired to an edge device input, (e.g. encoder,
camera or matrix.) 

    Not
Accessible

Likely the edge device or connection that the
input is wired to is not accessible or
unresponsive

ControlCenter

ControlCent
er 

OK

    Not
Accessible

Camera
Sequence

Camera
Sequence 

OK Cycle displays two or more cameras in
sequence in a single tile

    Not
Accessible

    OK,
Recording

System/
Organization

System –
(a.k.a. a

OK An independent system – the user can log in
separately to more than one system, and can
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Icon Description Status Comments

parent  
‘federation
system’) 

then access all edge devices belonging to that
system (subject to that user’s login/password
and access permissions) 

    Not
Accessible

    System –
Status
Failed
connection 

Failed
connection

    Connecting 
(in
progress)

Enterprise Represents a single Enterprise group

Site Represents a grouping of edge devices as a
single security site.

Microphone

Microphone
 - (Audio
Input) 

OK

    Not
Accessible

    Lost Audio
Signal

    OK,
Recording

    Audio
and/or
Recording
failed

Possible loss of audio signal or recording
problems with Archiver.

Speaker

Speaker OK External audio output (likely sent to an
amplifier and then to a speaker) connected to
an edge device audio line out (camera,
encoder, etc.).  

    Not
Accessible

Likely the edge device or connection that the
audio is wired to is not accessible or
unresponsive

Tile Layout

Tile Layout OK A defined layout specifically for video 

    Not
Accessible

Audio Layout
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Icon Description Status Comments

Audio
Layout 

OK A defined layout specifically for audio. 

View existing or drag and drop Speakers and
Microphones into the layout and then control
volume, mute, and speak

    Not
Accessible

Map

Map OK A graphic diagram (floor plan) or aerial picture
of the layout of a secured area that provides
the ControlCenter user an overview and
interface for cameras, devices, and more.

    Not
Accessible

Scene Tracker

Scene
Tracker

OK A panoramic view constructed from multiple
cameras

External Entity

External
Entity – 

An entity that works with a plug in or SDK
created entity. Consult an Administrator of your
system for more details.

Notes: 

1. The names of entities are followed by numbers in parentheses (n) – these are the
logical entity numbers which are used when operating a ControlCenter monitor from
a CCTV keyboard – see Using Keyboards.

2. Certain entities are only available on Latitude systems (examples: Enterprises,
Microphones.)

7.2 Viewing Tile Action Buttons

Button Entities Description

All This button displays the tile's logical ID, and is also used to arm it for
instant replays/alternative content (one click) or alarms (two clicks).
The button turns orange for the former, red for the latter, and blinks
when an alarm/instant replay activates.

Camera Click to start and stop listening to the audio inputs linked to the
displayed entity.

Camera Click to start and stop transmitting audio through a linked microphone.

Camera This button is used to start and stop manual recording of the camera
scene.

Camera Click to view an instant replay of the live video. You must have at least
one tile armed for alternative content to view instant replays.

Video Clip,
Sequence

Click to increase a video clip's playback speed (displayed by the tile
ID) or start forward playback when in reverse mode. 
When viewing a sequence, use the button to jump to the next camera.
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Button Entities Description

Video Clip,
Sequence

Click to pause a video clip's playback or, when viewing a sequence, to
prevent progress to the next camera until you click the button again.

Video Clip,
Sequence

Click to increase a video clip's reverse playback speed (displayed by
the tile ID) or start reverse playback when in normal mode. When
viewing a sequence, use the button to go back to the previous
camera.

Map The "Back" button when viewing a map (same as in a web browser).

Map The "Home" button when viewing a map (same as in a web browser).

Map The "Forward" button when viewing a map (same as in a web
browser).

Alarm Click to acknowledge an alarm.

Alarm Click to snooze an alarm.
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7.3 Tools Options Menu
The user also has a wide range of customization options.
For full details of the Tools Options, see the Help system. 

7.4 Remote Control Options
Note: Only available when connected to a Latitude system

The Remote Control feature is a virtual system formed by joining multiple independent
ControlCenter clients together. One of the systems acts as the Remote Control host.
Remote Control allows ControlCenter clients on the host system to view video sources
belonging to multiple independent ControlCenter installations simultaneously as if they were
on the same system.
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Once connected to a remote Directory, the ControlCenter Server creates a local
representative for each remote entity it can access. From the local user's point of view,
remote entities behave exactly like real entities, with only few limitations. The remote
entities are indicated in the entity trees with a yellow arrow superimposed on the entity icon.

The configuration of the real entities cannot be done through the remote entities. The local
attributes of the remote entities can be changed (such as logical ID, entity name, entity
description).

You can access and control the remote ControlCenter via the Navigation Tree.

You can control a remote ControlCenter via a CCTV keyboard or a PC keyboard by
selecting the desired monitor of the desired remote ControlCenter.

7.5 Alarm Display Mode
 Flat Mode

Flat mode is a simple method of showing alarms one after another (as they occur in priority
sequence). Each alarm is sent to the next available ‘armed for alarms’ tile/s. If an alarm has
more than one associated video, all available ‘armed for alarms’ tiles are used. If an alarm
has too many associated videos for the available tiles, the available tiles are used and the
remaining videos for that alarm are not displayed. When alarms are cleared, the next alarm
in the queue is displayed. There is no cycling of scenes. All the displayed scenes of an
alarm remain in their tiles until that alarm is cleared.

Alternative Modes
Note: Only available when connected to a Latitude system

In addition to Flat mode, the system supports two alternative modes - Block and Salvo, for
handling the situation where two or more alarms are automatically loading into a Layout that
has one or more Tiles enabled with 'Armed for Alarms'.

Block Mode: All scenes associated with an alarm type are shown, in sequence, in one tile.
You can see information about multiple alarms at the same time, if you have more than one
tile ‘armed for alarms’.

Salvo Mode: Only one alarm is displayed at any one time. As many scenes as possible of
that alarm are displayed on the available ‘armed for alarms’ tiles and they remain there for
the ‘dwell time’ of that alarm. Provided all scenes for the alarm have been displayed, the
next alarm in the queue according to priority is displayed. If you do not have enough ‘armed
for alarms’ tiles for the scenes of one alarm to be shown, then when the alarm dwell time
passes, the remaining scenes of that alarm are displayed before the next alarms appear.

Note: If your user settings have been set for you to work in Salvo Mode, it is important that
you keep sufficient tiles ‘armed for alarms’ so that you can see all the cameras associated
with an alarm.
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